AVAYA

Avaya Solution & Interoperability Test Lab

Application Notes for Telecorp Wall Display PLUS with
Avaya Call Management System — Issue 1.0

Abstract

These Application Notes describe the configuration steps required for Telecorp Wall Display
PLUS to interoperate with Avaya Call Management System. Telecorp Wall Display PLUS
captures the real-time split/skill call measurement data from Avaya Call Management System
to make available for users to display onto high-resolution displays.

Information in these Application Notes has been obtained through compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

Telecorp Wall Display PLUS captures the real-time split/skill call measurement data from Avaya
Call Management System (CMS) to make available for users to display onto high-resolution
displays, such as plasma screens, LCD screens, and computer monitors.

The Telecorp Wall Display PLUS system consists of three separate software applications — Wall
Display PLUS Client, Wall Display Shub Server, and Wall Display Driver. The compliance
testing focused on the interface between the Wall Display Shub Server and Avaya CMS. The
Wall Display PLUS Client was used to verify the real-time split/skill call measurement data that
were made available by the Wall Display Shub Server.

On Avaya Communication Manager, the split/skill contact center resources are configured to be
“measured” by Avaya CMS. When a call travels through a “measured” resource on Avaya
Communication Manager, the call measurement data is sent to Avaya CMS.

Contact center users such as supervisors can run the Wall Display PLUS Client software on their
desktops, and access the Wall Display Shub Server to review and display the collected split/skill
data onto high-resolution displays that can be seen by the agents. For the compliance testing, the
Wall Display PLUS Client software was used to verify the collected split/skill call measurement
data, and to format and preview the display of such data.
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Figure 1: Telecorp Wall Display PLUS with Avaya Call Management System
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The integration of the real-time split/skill call measurement data with Avaya CMS is achieved
through the Avaya CMS Supervisor interface. The Avaya CMS Supervisor application is
installed on the same server hosting the Telecorp Wall Display Shub Server application. Scripts
for the Avaya CMS real-time split/skill and the Avaya CMS integrated split/skill comparison
reports were created using the Avaya CMS Supervisor, which sets up the necessary parameters
and permissions. The Telecorp version of the scripts is then installed to collect the real-time
split/skill and integrated split/skill comparison data. The data is parsed by the Telecorp Wall
Display Shub Server and made available to the Telecorp Wall Display PLUS Clients for format

and display onto high-resolution displays.

These Application Notes assume the configuration and connectivity between Avaya
Communication Manager and Avaya CMS is already in place and will not be described.

2. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment

Software

Avaya S8700 Server

Avaya Communication Manager 4.0,
R014x.00.0.730.5

Avaya G650 Media Gateway

e TN799DP C-LAN Circuit Pack HWO01 FW024
Avaya Call Management System Server rldaa.h
Avaya C363T-PWR Converged Stackable Switch | 4.3.12
Avaya 4610SW & 4620SW IP Telephones (H.323) | 2.8
Telecorp Wall Display Shub Server and 1.1.7
Avaya CMS Supervisor running on 14.0.1A.04
Dell Inspiron E1505 Windows XP Professional
Telecorp Wall Display PLUS Client running on 2.2.0

Dell Precision 380

Windows XP Professional SP2
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3. Configure Avaya Communication Manager

The detailed administration of contact center resources and connectivity between Avaya
Communication Manager and Avaya CMS are not the focus of these Application Notes and will
not be described. For administration of contact center resources and connectivity to Avaya
CMS, refer to the appropriate documentation listed in Section 11.

This section provides the procedures for how to enable split/skill measurement data to be sent to
Avaya CMS.

3.1. Administer Measured Split/Skill and Agent

Use the “change hunt-group n” command, where “n” is the number of the split/skill group to be
measured by Avaya CMS. Navigate to Page 2, and set the measured field to “external” to
enable measurement data on the split/skill group to be sent to Avaya CMS. Repeat this step for
all split/skill groups that will be measured by Avaya CMS.

change hunt-group 510 Page 2 of 3
HUNT GROUP
Skill? y Expected Call Handling Time (sec): 180
AAS? n Service Level Target (% in sec): 80 in 20

Measured: external
Supervisor Extension:

Controlling Adjunct: none

Timed ACW Interval (sec):
Multiple Call Handling: none
Redirect on No Answer (rings):
Redirect to VDN:
Forced Entry of Stroke Counts or Call Work Codes? N

For the compliance testing, two split/skill groups with group numbers 510 and 520 were
configured to be measured, as shown below.

list hunt-group 510 count 2

HUNT GROUPS

Grp Grp
No. Name/ Grp ACD/ No. Cov Notif/ Dom Message
Ext Type MEAS Vec MCH Que Mem Path Ctg Adj Ctrl Center
510 Telecorp Skill 510
34510 ucd-mia Y/E SK noney O n n
520 Telecorp Skill 520
34520 ucd-mia Y/E SK noney O n n
TLT; Reviewed: Solution & Interoperability Test Lab Application Notes 4 of 30
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In the compliance testing, one agent with physical extension 24511 and logical extension 35511
was used as an available agent for skill group 510, and two agents with physical extensions
24513-24514 and logical extensions 35513-35514 were used as available agents for skill group
520.

list agent-loginlD 35511 count 3

AGENT LOGINID

Login Name/ Dir Agt COR Ag SO Skil/Lv Skil/Lv Skil/Lv Skil/Lv
1D Extension AAS/AUD Pr
35511 Telecorp Agent 1 Ivli n 510/01 / / /
24511 / / / /
35513 Telecorp Agent 1 Ivli n 520/01 / / /
24513 / / / /
35514 Telecorp Agent 1 Ivli n 520/01 / / /
24514 / / / /
TLT; Reviewed: Solution & Interoperability Test Lab Application Notes 50f 30
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4. Configure Avaya Call Management System

The connectivity between Avaya CMS and Avaya Communication Manager is assumed to be in
place and will not be described. In addition, these Application Notes assume a user name and
password has been created with report access permissions. This section provides the procedures
for administering split/skill dictionary names.

4.1. Administer Split/Skill Dictionary Names

Use a terminal emulator to connect to the Avaya CMS server, and log in with the proper
credentials. Enter “cms” at the command prompt. The MainMenu screen is displayed. Select
Dictionary > Splits/Skills, as shown below.

@' Avaya Terminal Emulator - RAcms

Profile  Edit  Connection  Help

MalnMeni

ke por == E—————
in Identifications

|
|
|
|
|
|
Srouns |
Splits/gkills ]
CUNK oups |
- h |

|

|

|

|

|

|

|

|

Help Window Commands Keep Exit Scroll Current Faintdenu
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The Dictionary: Splits/Skills dialog box is displayed. Enter a descriptive name for Split/Skill
name, and a desired description. For the Split/Skill number field, enter the first split/skill group
number from Section 3.1. Tab over to Add and press Enter.

vaya Terminal Emulator - RAcms

Profile  Edit  Connection Help

Dictionary: Splits/gkills devoon3l
Al
skill 510

Help Window Commands Keep Exit Scrall Current Maintenu

Repeat this procedure to create dictionary names for all measured splits/skills groups created in
Section 3.1. Shown below are the split/skill groups used for the compliance testing.

Avaya Terminal Emulator - RAcms
Profile  Edit  Connection  Help

devoonil

Z matches found; permitted ones displayed
guacessful

Help Window Commands Keep Exit Scroll Current taintdenu
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5. Configure Avaya CMS Supervisor

This section provides the procedures for configuring the Avaya CMS Supervisor to create two
report scripts. The procedures include the following areas:

e Launch Avaya CMS Supervisor
e Administer real-time split/skill report script
e Administer integrated split/skill comparison report script

5.1. Launch Avaya CMS Supervisor

From the Telecorp server, start the Avaya CMS Supervisor application by selecting Start > All
Programs > Avaya > CMS Supervisor R14 > CMS Supervisor 14.0 -- English. The Options
screen is displayed, as shown below. Click New to connect to a new CMS server.

(5] Options

{CHS Servers

P
—

Servers:

(=0

N
I
|

[ Manual Login [using Server Mame selected abowve]

Help

:

0K | Cancel |
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The Server Properties screen is displayed next. In the Server Name field, enter the IP address
of the Avaya CMS server, in this case “192.45.120.50”. Retain the default values in the
remaining fields, and click OK.

& Server Properties

Choose a connection method and set itz options.

Seryer Name: [152.45.120.50

. Connection
Server Version:

CMSR14 i

Metwork Settings

o Metwork " Serial " Modem i 55H

CMS Metwaork Address: |

Metwark Port: |23

Help | u] | Cancel |

The Options screen is displayed again with the IP address of the Avaya CMS server from above.

Click OK.

= Options
CMS Servers 1 ]
Servers: Mew
Bemove
Properties
[ Manual Login [using Server Name selected above)

The Avaya CMS Supervisor screen is displayed next. Retain the default value in the CMS
Server field, and enter valid credentials for the Login ID and Password fields. Click OK.

TLT; Reviewed:
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Lagin Information

&) CMS Server | 132 4512050 |
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1] 8 | Cancel | Help |

Solution & Interoperability Test Lab Application Notes
©2008 Avaya Inc. All Rights Reserved.

9 of 30
Telecorp-CMS



5.2. Administer Real-Time Split/Skill Report Script

The Avaya CMS Supervisor screen is displayed next. Click on the Select a Report icon
circled below to create a report.

Avaya CMS Supervisor - 192.45.120.50 Mi=13

Connect  Commands  Tools  Scripks Help

EEEEIRE

@ RR R

The Select a Report screen is displayed. Select the Real-Time tab, and select Split/Skill and
Split/Skill Report as shown below. Click OK.

Bl Select a Report
Real-Time Hiztarical |nteqrated
Fiun Feport for ACD: Repoart:
devcon3i ﬂ Graphical Status ~
Category: Graphical Top Skill Status
Agent Reszervel ALk Agents Repart
Other Feserve? &l Agents Feport
=yt Skil AU Repart
Trunk/Trurk Group Skill Status
YON Skill Top Agent
Vector Splt/Skill by Lacation
ChS cuztom st
: Split/Skill Beport
Top Agent Status

Dezcription
Dizplays a zummary of current zplit/zkill activities

Script... Help

ik
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The Split/Skill Report screen is displayed. Click on the Browse icon circled below.

4T Split/Skill Report

Splits/Skills: |

Fieal-Time Options

Befrezh Every = Seconds

[v Enable Report Thresholds
[ Bun Mirimized

Cancel ‘ Help

FEX
Inputs

devcon3l

The Browse Split/Skills screen is displayed. Select the split/skill group dictionary names from
Section 4.1 in the Choices pane, and move the selection to the Selected Splits/Skills pane by
clicking Add >>. Click OK.

3

Browse Splits/Skills

o111 Use the choices on the left to create the list of selected Splits/Skillz on the right.

Choices Selected Splitz/Skills
(& Awailable S plits/Skill

T ralane aplisee Telecorp skil 610
Telecorp skill 510 Telecorp skill 520
T elecorp skl 520

™ Range of Splits/Skillz

First: l:l to Last: l:l

Femave
0k | Cancel | Help |

Splits/Skills field. Click OK.

The Split/Skill Report screen is displayed again with the selected split/skill groups in the

4T Split/Skill Report

Splits/Skills: |Telscorp skill 510 Telecorp skil 520 « | [E4]

Real-Time Ophions

FRefrezh Every = Seconds

[v Enable Report Threshalds
[~ Run Minimized

e DK

Cancel Help

devcon3l

)5/
| npLts
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The Split/Skill Report screen is updated with a snapshot of the actual report. Select Edit >
Export All Data from the menu bar.

4T Split/Skill Report
Report  Edit Format  Tools  Cptions  Help

SplitSkill Telecorp s Telecorp s
Skill State NORMAL NORMAL
Calls Waiting 0 0
Oldest Call Waiting :00 100
Avg Speed Ans
ACD Calls 0 0
Avg ACD Time
Ahan Calls 0 0
Avg Aban Time
Agents Avail 1 1
Agents Ringing 0 0
Agents on ACD Calls 0 1]
Avents in ACW 0 1]
Agents in Other 0 0
Agents in AL 0 1
Agents Staffed 1 2

Double Click. To Fun Format T able Threzhaldz: On dervcon3l

The Export All Data screen is displayed next. Select and enter values into the fields as shown
below, and click Script.

Export All Data F§|

Destination

" Ewport to Clipboard
{* Ewport to File:

C:htelecorphavayahtest_esport bat ﬂ ﬁ |

Ewpart Farmat

Field Separator: |; j

Text Delimiter: | [none] j

[v Export NullValues as Zero
v Include Labels and Headers
[w E=port Time Durations in Seconds

] Cancel Script... Help
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The Save as Script screen is displayed next. Retain the default values, and click Save.

Sawve as Script

This window allows you to save the curent dizplay or resulting operatioh as a
zoript. There are bwo seript bypes: interactive and automatic. Interactive scripts
are run with a user present. Autamatic scrpts win entirgly in the backaground.

Before pressing Save. specify the soript type. To save a new script, enter a
unigue script name. Select an existing sonpt to replace its contents or to add
thiz operation to the end of the existing soript.

Save i |L’f} avaya j . =5 Ea-

File: name: |E:-cpu:|rt Drata-SplitSkill Report Save

Save a3 type: |Automatic script [* acsauto) ﬂ Cancel

Help

el

In the Save as Script — User Information screen below, enter valid credentials and click OK.

m| Save as Script - User Information

ou rust specify & CMS uzer ID and pazsword befare any automatic
zoripte can run on thiz computer.

If wou share thiz computer with other uzers. all automatic scrpts they
create will un using the permizsions for the CkS uzer pou specify here.

rou muzt enter the correct pazsword. The pazsword will be validated
later when the zcript is wn.

Uzer ID; |super

mem

Pazsword:

Confirm Pazzward: |mm1

oK | Cancel | Help

The Save as Script dialog box is displayed. Click OK.

Save as Script

The automatic scripk Export Data-3plitskill Report, acsauto has been saved. You can schedule it to run at a laker time using any

Windows scheduling package.
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5.3. Administer Integrated Split/Skill Comparison Report Script

From the Avaya CMS Supervisor screen, click on the Select a Report icon circled below to
create another report.

Avaya CMS Supervisor - 192.45.120.50

(=1

Connect  Commands  Tools  Scripts Help

EFRE

@ HAhH

The Select a Report screen is displayed. Select the Integrated tab, and select Split/Skill and
Comparison Report as shown below. Click OK.

Bl Select a Report

Real-Time Higtorical Integrated
Fiun Fepoart for ACD: Beport:
devcon3 ﬂ Actual Relative to Target
Categony: omparizon B eport
Py Graphical Skill Overload
raphical Split/Skill Yigw
WON
Dezcription
Shaoves current statug and curmulative data for one or more splitz or skills
Script... | Help
Qk Cancel
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The Split/Skill Comparison screen is displayed next, with the Splits/Skills field already filled
in. Retain the default values, and click OK.

41 Split/Skill Comparison E' |E|E|

Inputs

SplitzAS kills: |Telecnrp gkill 310;Telecorp zkil 520 j @

Curmulative Data Ophions

Feport Data Start Time: |EIEI:EIEI IZI- |Wednesda_l,l, March 19, 2003

Feal-Time Options

Befrezh Ewveny = Secondz

[v Enable Repart T hresholds:
[ RBun Minimized

k. Cancel Help

devcon

The Split/Skill Comparison screen is displayed with a snapshot of the actual report. Select Edit
> Export All Data from the menu bar.

3t 5plit/Skill Comparison E| [E| Pz|

Report  Edit Format  Tools  Options  Help
Report Data Start Time: 12:00 AM 31972008

Splitrskill Skill State Agents Calls Oldest  ACD  Awvg Ahan  Awg Aban Ay

Staffed  Waiting Call Calls ACD  Calls Time Speed
Wiraiting Time ANns
Telecorp skill 510 MORMAL 1 1] 00 1] 1]
Telecorp skill 520 MORMAL 2 1] 00 1] 1]

Threzholds: On devcondl
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The Export All Data screen is displayed next. Select and enter values into the fields as shown

below, and click Script.

Export All Data

Destination

" Esport to Clipboard
f+ Ewnport to File:

C:htelecaorphavapattest_export? bt j ﬁq

Ewport Format

Field Separator:  |; -

Text Delimiter: | [none] e
[V Esxport NullValues as Zera

[ Include Labels and Headers
W i soort Dime Durabons i Seconds

0k | Cancel | Script... ‘ Help

3

The Save as Script screen is displayed next. Retain the default values, and click Save.

Save as Script

Thiz window allows pou to save the current dizplay or resulting operation as a
zcript. There are bwa sonipt types: interactive and automatic. Interactive scripts
are run with & uger present. Automatic scripts run entirely in the background.

EBefore pressing Save, specify the script type. To save a new script, enter a
unique script name. Select an existing script to replace its contents or to add
thiz operation ta the end of the existing script.

Save in; |lﬂ avaya ﬂ |‘j< v

@] Export Data-5plitskil Report, acsauto

File name: |E:-c|:0rt Data-SplitSkill Comparizon
Save as type: |Automatic script [*.acsauta) j Cancel
Help

The Save as Script dialog box is displayed. Click OK.

Sawve as Script

The automatic script Export Data-Splitskil Comparison, acsauto has been saved, ¥ou can schedule it bo run at a laker bime using
any indows scheduling package.
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6. Configure Telecorp Wall Display Shub Server

This section provides the procedures for configuring the Telecorp Wall Display Shub Server.
The procedures include the following areas:

e Rename script file extensions
e Administer Telecorp report generation

Note that configuration of Telecorp Wall Display Shub Server is typically performed by the
Telecorp technicians. The procedural steps are presented in these Application Notes for

informational purposes.

6.1. Rename Script File Extensions

From the Telecorp server, open a Windows Explorer window, and navigate to the directory
C:\telecorp\avaya, as shown below. Note the two text files with extension “.txt” and the two
script files with extension *“.acsauto” created from Sections 5.2 and 5.3.

Ci\telecor plavaya

@Back g }?

Address |03 C:\telecorplavaya
Folders

@' Deskkop
[# f_,} My Documents
B % voLanDa
[z = Local Disk (C:)
I Config.Msi
123 cygwin
& 25 dell
[# [2) Documents and Settir
[ drivers
& i3 386
I php
# [ Program Filds
[£5) RECYCLER

= [0) telecarp
& ) avava
# I3 Plasma
# ([T Resource

I3 Swstem Yolume Inforr]

=

T—

File Edit “iew Favorites Tools  Help

= [ I
1 [r=h -
7 Search |I" Folders .

Marng

| [)2008_03_18

1 ﬁagent
[hrawdata
[hskillset
;;’:ltoparse

E’] AvayaParse, exe
|‘§”|, MsgBoxEs, bxk

Mamelnde:x, dat 1KE
ESIeep.exe 36 KB
| EL Tt — 178'KE

lEﬁ-'.*l*‘]§E><|:u:urI: Data-splitskil Comparison. acsa,
F::: Export Data-Splitskill Report. acsauto
r;] test_expaorkse bk

_@port.txt

Size

Type

File Folder

File Folder

File Folder

File Folder

File Folder

Application

Texk Document

DAT File

application

Text Document
Avaya Supervisor A,
Bvaya Supervisor &,
Texk Document

Texk Document
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Rename the two script files to use a different file extension, so that the files would not be
recognized as script files by the system. In the compliance testing, the two script files were
changed to have the file extension “.acsauto.old”, and moved to a manually created folder along
with the two text files.

@ C:\telecor plavaya

File  Edit ‘Wiew Faworites Tools Help

@ Back - 2 l‘ﬁ ;__:' Search

Address | ([0 C:itelecorplavaya

I_Lh‘ Folders

Folders X Mame - Size | Type
(& Deskiop T[] Eh2mnan3ts File Folder
2} My Documents [ Chagent File: Falder
B 4 YOLAMDA [Zhjust in case > File Falder
[=) e Local Disk {i22) [Drawdata File Folder
1) Config.Msi [skillset File Folder
[ 1) cygwin [Citoparse File Foldsr
[# 125 dell E] AvayaParse.exe 331 KB Application
Documents and Settir ] MsgBoxEx.txt 1 KB Text Document
drivers NameIndex.dat 1KE DAT File
=| Cslesp.exe 36KE Application
) php ) Timing.txt 178KB  Text Document

# .33 Program Files

|5 RECYCLER

1) Swstem Yolume Infarr
[= 125 kelecorp

ol ) awaya

# I5) Plasma

® £ Resource

6.2. Administer Telecorp Report Generation

Copy the file Telecorp Export.acsauto from the Telecorp installation CD into the

C:\telecorp\avaya directory, as shown below. Open the Telecorp Export.acsauto script file
with an application such as Note Pad for editing.

Atelecor plavaya

Filz

@Back i > !? /T:'Search !L‘,__L Folders

Address () Citelecorpiavaya

Edit Wiew Faworites  Tools  Help

'

Size

Folders X Mame = Type
(& Deskrop | 200803 18 File Folder
# (£} My Documents T r::::lagent Fil= Falder
= YoLANDA [just in case Filz Falder
= @ Local Disk (C1) [Cirawdata File Falder
22 Canfig.Msi [skillset File Folder
& ) eygwin [Citoparse File Folder
& ) del E] AvayaParse.exe 381 KE  Application
& IE3) Documents and Settir I?] MsgBoxEx. bxk 1 KB Text Document
& £ drivers [ mametndes. dat LKE DAT File
& ) i386 =| slesp exe_ 36 KB Application
= ﬁ php <: Q?:;]ETelec_g_l_'_p_E_:_c_Eg[t.acsauto SEE Awaya Supervisor &,
& |7 Pragram Files =} Timing, kxt 178 KB Text Document
[C0) RECVCLER
(L2 Swstem Yolume Inforr
= [£5) kelecorp
D avaya
= ) Plasma
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In the Telecorp Export.acsauto script file, set the SERVERNAME in line 2 to the IP address
of the Avaya CMS server, in this case “192.45.120.50” as shown below.

) EXpOrt.acsauto

File Edit Search Wiew Format Language Sattlngs Macro Run  TextFx F'Iuglns Window 7
cEEREER 4hD e Ay 2 BE =1 [FD

=] canéts.aap'i deletesmlzting, asp ] B fields s2p l getshing asp ] histancalasp ! master asp 1
1 'LANGULGE=ENT

hSERﬁERNAHE=1az.45.120.50

Public Sub Main()

Jet objhApp = CreateChject ("W3cript.3hell™)

&
3
4
a3
&

Search for “Splits/Skills”, and set the split/skill group numbers to the numbers from Section 3.1,
as shown below. Note the use of semicolon “;” to separate the group numbers. There are a total
of four places in the script file that needs this change. The first three places are shown below.

File Edit Search Miew Format Language Sattlngs Macro  Run  TextFx F'Iuglns Windaw 7
cEEBEER 4HD e A 2 BE =1 [ED |

=] canéts.asp'i deletexmlsting, asp ] B fielde s2p l getsifing asp ] hiztancalasp ] masterasp ]

26 'TELECORP Manual Configquration - Change the line bhelow to add
o '## Parameters.Add "510;520","Splits/Skills"™
28 '## Parameters.lidd "*7, " EndProperties”

29 '"## Parameters.Add "*"," BeginViews"

30 '## Parameters.Add "+, " EndViews"

C:\telecorpiavayavlelecorp EXport.acsauto

File Edit Search Wiew Format Languaga Sattlngs Macro Run  TextFx F‘Iuglns Window 7
i O = - . = £223 T =

o E B S0 & O i-'k' 2C hy 2% BHE = |=_=!'-

El c:ﬁ‘sté.asp‘! da1até:-:mlstrihg.asp'] H fislds asp ] aetsting s5p ] B histonical asp. l B rmaster ap ]
& ] . Bep.UWindow.Top = 2872
61 : . BEep.Window.Left = 5752
B ; ; Fep.Window.Width = 7635
(45 i ¢ Bep.UWindow.Height = 8255
o4
(=1t
(=i}
67 Rep.SetProperty "Splits/Skills”, "510;520"
(ota]

TLT; Reviewed: Solution & Interoperability Test Lab Application Notes 19 of 30

SPOC 5/28/2008 ©2008 Avaya Inc. All Rights Reserved. Telecorp-CMS



File Edit Search Yiew Format Language Setkings Macro Run TextFX  Plugins  Window 7
cHHESH 4Dk 2 A% 23 BH =1 |56

=] c:ujn‘st's'.asp'l deietéwmlstrhg.asp'] fieldsiasp ] getating asp ! B histancal.asp. I B masterasp |

105 '## Parameters.Add "The report IntegratedhSplit/Skillh Compar
108 '## Parasmeters.hdd "ET, " BeginProperties"

107  ["## Parameters.idd "510;5207","Splits/Skills”

1as "#ff Parasmeters.Ldd mTET, " EndProperties™

102 '#f Parameters.Aidd "*"," BeginViews"

After setting the split/skill numbers in all four places, including the one below, select File > Save
from the menu bar to save the changes.

C:\te Ei:-'rp aifafalt}es't_ex'tbrt'_script.-%\csai.l o

File Edit Search Wiew Format Language Settings Macro Run TextFr  Plugins  Window 7
cEHEHBE SR O 2 iy 25 BE =1 |EE
= c:ujn‘st's'.asp'l deieté:-:mlstrih’g.asp'] figlels azp ] getstiing asp ] B histarcal asp. I B master amp

156 Fep.Window.Top = 3532
dete T, Fep.Window.Left = 4762
1538 Fep.Window.Width = 9675
REG ) Fep.Window.Height = 4935
140
SBaal
142
4G Fep.SetProperty "sp lits/3kills™, "510; 520"
1434
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In the Windows Explorer window, double-click on AvayaParse.exe to start the application.

‘e C:\telecorplavaya

File Edit View Favorites Tools Help
@ Back - \_,J l? Jf:\] Search H{j Folders -
Address Iﬁ;j Critelecorphavaya
Folders X Mame - Size  Type
(@ Deskiop 7[2] [Chz008_03_13 File Folder
& (£} My Documents " | [Chagent File Falder
=9 rOLANDS [Shijust in case File Folder
=) % Lacal Disk {C2) [Dhrawdata File: Folder
1) Config.Msi [Chskillset File Folder
& 13 cygwin [Citoparse File: Folder
& 1) dell @ fvavaParse exe 381 KB Application
& a Documents and Settir Ej MsgBoxE:x:. Ext 1KE Text Docurment
@ () drivers [E Mameindex. dat 1KB DAT Fils
& ) i386 = ESIeep.exe 36 KE  Application
=] @ php @: test_export_script.acsauto SKE Avaya Supervisor A...
® IC3) Program Files E] Tirnirg. kxk 185 KE  Text Document
[3) RECYCLER [2) Exit bt 0KB  Text Document
120 System Yolume Inforr
= 123 telecorp
2D avaya
® |23 Plasma

The Telecorp Products Avaya Parser dialog box will appear as shown below.

‘B Telecorp Products Avaya Parser

SHub Id:
1 W aiting for file to process. ..

Status:
JLast parsed aon; Tue Mar 18 15:55:23 2008

Start Script Stop Script
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7. Interoperability Compliance Testing
The interoperability compliance test included feature and serviceability testing.

The feature testing focused on verifying Telecorp Wall Display PLUS parsing and displaying of
split/skill data from Avaya CMS.

The serviceability testing focused on verifying the ability of the Telecorp Wall Display PLUS
server to recover from adverse conditions, such as disconnecting the Ethernet cable to the
Telecorp Wall Display Shub Server.

7.1. General Test Approach

The feature test cases were performed manually. Incoming calls were made to the measured skill
groups to enable measurement data to be sent to Avaya CMS. Manual call controls and work
mode changes from the agent telephones were exercised to populate specific fields in the skill
data.

The serviceability test cases were performed manually by disconnecting/reconnecting the LAN
cable to the Telecorp Wall Display Shub Server and to the Avaya CMS server.

The verification of all tests included checking of proper display of data at the Telecorp Wall
Display PLUS Client, and of comparing the displayed data with the real-time split/skill and
integrated split/skill comparison reports from the Avaya CMS Supervisor.

7.2. Test Results
All test cases were executed and passed.

There was one observation from the compliance testing. For data parameters that involved time,
such as Average Speed Answer and Average Abandon Time, the Avaya CMS Supervisor
rounded the data to the nearest second, whereas the Telecorp Wall Display Shub Server
truncated the data to the nearest second.
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8. Verification Steps

This section provides the tests that can be performed to verify proper configuration of Avaya
CMS Supervisor and Telecorp Wall Display PLUS.

8.1. Verify Avaya CMS Supervisor
From the Avaya CMS Supervisor screen, select Tools > Maintenance from the menu bar.

Avaya CMS Supervisor - 192.45.120.50

Connect  Commands Tools  Scripks  Help

@ 2 FL 3/20/2008 04:08:53 PM

The Maintenance screen is displayed. Select the Operations tab, and select Connection
Status. Click OK.

[#] Maintenance PZ|
i'ﬁ'ﬁé'i'éii'iiii'é""'"""""""?l Reparts ]

Dperationz:

ACD Status

Archiving Status

Back Up Data
Eackup/Restore Devices
Connection Status
Printer Administration
Restore Data

ACD:

|devcon31 j
Script. Help
oK Cancel |

The Connection Status screen is displayed next. Select the proper system from the ACD(s)
field drop-down list, in this case “devcon31”, and click on the Find a Match icon circled below.
Verify that the updated screen shows the Session field to be in “data transfer” and “normal”, and
that the Connection field to be “operational”.

@ Connection Status
Actions  Edit  Help
= |

Application: data transfer
Session: data kransfer normal
Connection: operational
Date/Time: 3/20/2008 4:42PM
Errors:

1 matches found
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8.2. Verify Telecorp Wall Display PLUS

Prior to verifying Telecorp Wall Display PLUS, make calls to the measured split/skill groups on
Avaya Communication Manager, to enable measurement data to be sent to Avaya CMS.

8.2.1. Launch Telecorp Wall Display PLUS Client

From the Telecorp client PC, start the Telecorp Wall Display PLUS Client application by
selecting Start > All Programs > Telecorp > BigClient. The Connect to Software Hub screen
is displayed. Enter the IP address of the Telecorp Wall Display Shub Server into the IP Address
field. Retain the default values in the remaining fields, and click OK.

M Connect to Software Hub E'E'E'

Connect to Shub

(]9
" Mame 4
& Ip Address 192 . 45 . 20 .234 g‘mce'
™ Use SocksS Praxy Find System Settings

Address Part

User Mame Password

Local Address Part

Winsock Info

The Wall Display PLUS Client screen is displayed. Select (Plasma) Plasma Display.2.2.0
from the Available Displays field drop-down list.

=] wall Display PLUS Client
Available Displays —

-]

[Plasma) Plasma Display, 2.2.0

el
Graph

Ver i ALl B 1
' | Finished Collecting Data [SEFTE

Media

Threshald
Ticker
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The Wall Display PLUS Client screen is updated. Click and drag the Table icon from the left
pane into the right pane, as shown below. Double-click in the Winl... Table object Data

Source in the right pane.

=l walil Display PLLUS Client

Awvailable Displavs

|(Plasma] Plasma Display, 2.2.0

Ticker

The Table Properties screen is displayed. In the Data Source column, select Avaya
Supervisor.

Table Properties

Data Available Source Selected
Source Groups Elements Elements

Ayana Superyvisor

Up
D own
Selected  Fiows: 0, Columns: O Cancel
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The screen is updated with parameters in the Available Groups column. In the Available
Groups column, select the split/skill group dictionary names from Section 4.1.

Table Properties

Available Source Selected
Groups Elements Elements
510
520
Avaya Intl Sal
Ayaya Intl Sal

Ayaya S Sales
Up

[ o

[Selected  Rows: 2, Calumng; 4 Mext | Cancel I

The screen is updated with parameters in the Source Elements column. Double click on each
desired parameter from the Source Elements column, to move the selection to the Selected
Elements column. The selected parameters will be displayed onto the plasma display. Click
Next.

Table Properties

Data Available Source Selected
Source Groups Elements Elements
510 Abn Calls ACD Calls
520 ACD Calls Abn Calls
Awaya Intl Sal Agentz ACD Callz Auwg ACD Time
Awaya Intl Sal Agentz ACW Avg Abn Time
Awaya S Sales Agents AL

Agents Available Lp
Agentz Other

Agentz Ringing
Agents Staffed
ASA

Awn Abn Time
Awg ACD Time
Callz " aiting

Dldest Cal P

Selected  Rows: 2, Columnz: 4 Mest | Cancel
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The Table Properties screen is updated, as shown below. Click Finish.

Table Prupertles

Telecoxp skill 510
Telecoxp skill 520 )

Selected  Rows: 2, Columnz: 4 Finizh | Cancel ‘

The Wall Display PLUS Client screen is displayed again. Click on the Send Display Data icon
toward the top of the screen.

=] wall Display PLUS Client
Available Di=plays

[[Plasma) Plasma Display, 2.2.0 |
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The Display Viewer screen is displayed with the actual split/skill data captured via Avaya CMS
Supervisor.

= Display Viewer

Data
Source

Telecorp
skill 510

Telecorp
skill 520

Below is a sample screenshot showing additional customization that can be made to the plasma
display, including Rich Site Summary (RSS) feed, video feed, table display, graph display, and
ticker threshold text display.

m DiEplay Viewer:

Data Source|ACD

Telecorp
skill 510
Telecorp
skall 520

Call times are great everyone. Don'’t forget to mention our upcoming
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9. Support
Technical support on Telecorp Wall Display PLUS can be obtained through the following:

e Web:  www.telecorpproducts.com
e Phone: 800-634-1012
e Email: support@telecorpproducts.com

10. Conclusion

These Application Notes describe the configuration steps required for Telecorp Wall Display
PLUS to interoperate with Avaya CMS, via the Avaya CMS Supervisor interface. All feature
and serviceability test cases were completed successfully.

There was one observation from the compliance testing. For data parameters that involved time,
such as Average Speed Answer and Average Abandon Time, the Avaya CMS Supervisor
rounded the data to the nearest second, whereas the Telecorp Wall Display Shub Server
truncated the data to the nearest second.

11. Additional References
This section references the product documentation relevant to these Application Notes.

e Administrator Guide for Avaya Communication Manager, Document 03-300509, Issue 3.1,
February 2007, available at http://support.avaya.com

¢ Avaya Call Management System Switch Connections, Administration, and Troubleshooting,
Document ID 07-601582, February 2006, available at http://support.avaya.com.

e Avaya Call Management System Release 14 Software Installation, Maintenance, and
Troubleshooting Guide, Document ID 07-601578, February 2007, available at
http://support.avaya.com.

e CentrEE Wall Display / PLUS User Guide, available as part of the Telecorp Wall Display
PLUS Client software install.
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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